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A p p e n d i x  A :

OVERVIEW OF MINITAB

Starting Minitab:

To launch Minitab, click your (left) mouse button two times quickly while pointing to the
Minitab icon or the Minitab Student icon:

Once in Minitab:

Once you start Minitab, the Minitab menu bar will appear across the top of the screen:

Macintosh Student Version

Windows Versions

Minitab will open two windows: the Data window and the Session window. You may see only
the Data window (which looks like a spreadsheet) if the windows are placed on top of each
other. To see the Session window, you can click (and hold) on Window in the menu bar.
This will show the Window menu and list all the available windows. Then drag the mouse
to Session and let go to see the Session window, e.g.:

A series of menu steps like this will be written as Window Session throughout this text.
You can then choose Data from the Window menu (Window Data) to go back to the Data
window.
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612 ■       Appendix A: Overview of Minitab

The Data window is used for entering, viewing, and editing data. Each column contains
data for a different variable. The rows contain the observations for different observational
units:

Macintosh Versions                               Windows Versions

The Session window is used for entering Minitab commands that tell the program what to
do:

Macintosh Versions                                  Windows Versions

You should always click in the Session window to highlight it before you start entering com-
mands. In the Windows Professional version you need to select Editor Enable Command
Language from the menu before you will see the MTB> prompt. Minitab commands can
also be given using the menus across the top of the screen.

You can resize and move these windows for more convenient viewing. Click on the box in
the lower right corner of the window and drag to resize. You can also click and hold the
mouse button down on the top bar of the window and drag the mouse to move the window.

Ø
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Entering Data into Minitab:

To type data into the Minitab worksheet directly, activate the Data window and type each
data value into a different cell, hitting Return, Enter, Tab, or one of the arrow keys to move
from cell to cell. Remember that each column contains data for a different variable.

In the Professional versions and the Windows Student version, the arrow in the upper left cor-
ner of the Data window determines the direction in which the Minitab cursor moves when
you press Enter/Return.

Clicking the mouse on this arrow changes its direction. If the arrow is pointing down, hit-
ting Return/Enter moves you to the next row in the same column. If the arrow points to
the right, hitting Return/Enter moves you to the next column in the same row.

Opening an Existing Minitab Worksheet:

The data sets in this book are available in Minitab worksheets. You can open such a file by
choosing File Open Worksheet from the menu bar. You will then see a list of saved work-
sheets (with the .mtw extension).

Note: In the Windows Student version, you will be asked to select a file type. In this book, all
files will be “Minitab Worksheets,” so just click on the SELECT FILE button.

Once you find the file you want, you can click on the file name once to highlight it, and
then click on the OK/OPEN button, or you can double click on the file name. Check that
the data now appear in the Data window.

Note: In this book, we assume that the Minitab worksheets are stored in the default Minitab
Data folder. If the data are stored elsewhere, e.g., on your disk, you will need to change
folders. See Activity 2-2 on page 25 for an example.

Using Minitab Commands:

Commands for Minitab are either typed in at the MTB> prompt in the Session window or
selected through the menu bar (notice that after selecting a command with the menus,
the equivalent session commands appear in the Session window). In this book these com-
mands will appear in this font. As you use Minitab you will find some situations for
which typing the command directly is easier and others for which using the menu bar is
easier. Each command produces output or updates the Data window. Output appears
either in the Session window or in a special graphics window.

Ø
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Subcommands:

You will occasionally want to specify a subcommand to a command in the Session window.
Minitab uses a semicolon to signify that the next line should be a subcommand. For exam-
ple:

MTB> hist c1;
SUBC>

The prompt changes to SUBC> because Minitab is now expecting a subcommand. You can
continue to issue subcommands by ending each line with a semicolon. To indicate that you
are finished with subcommands, type a period at the end of the last subcommand. For
example:

MTB> hist c1;
SUBC> nint 5;
SUBC> by c2.

Minitab will produce the histogram and then change back to the MTB> prompt, awaiting
your next command.

Reverting to a Minitab Worksheet:

In the Macintosh versions, if you make changes to a Minitab worksheet but then want to
return to the last saved version of the worksheet, choose File Revert Worksheet from the
menu bar. In the Windows Professional versions, you may be able to choose File Restart
Minitab, clicking on NO when asked if you want to save changes to the data file.

Opening an Empty Minitab Worksheet:

If you have been working in Minitab and want to change to a new (empty) worksheet,
choose File New Worksheet from the menu bar. Minitab will ask whether you want to
save any changes you made to the previous worksheet.

Deleting Data:

To delete a cell entry, click the mouse on the undesired value and press the Delete/Back-
space key. When you hit Return/Enter, the value will be replaced by a *, which Minitab
uses to represent a missing observation.

To delete an entire row, click the mouse in the undesired row in the Data window and
choose Editor Delete Row (Macintosh Student, making sure you choose the Editor, not
the Edit, menu) or Manip Delete Rows from the menu bar (other versions). In the latter
case, specify the row number(s) in the first box and which column(s) you want the row
values to be deleted from in the second box. This allows you to delete rows from a subset
of columns, e.g., rows 1, 2, and 5 from C1. Alternatively, you can also type:
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MTB> dele 1:2 5 c1

at the Minitab prompt in any version of the Minitab program.

To delete an entire Minitab column, e.g., C1, type:

MTB> erase c1

at the Minitab prompt or choose Manip Erase Variables in the Professional versions and
Windows Student versions.

Pending Cell Change/Dimmed Menu Items:

To move from cell to cell in the Data window, you can use the arrow keys, the tab key, or hit
Return/Enter. You must finish putting data in a cell (complete the cell) before you can
execute a command. When you have not completed a cell, many menu items will be
dimmed so that you cannot select them. If you then try to execute a command in the Ses-
sion window, Minitab will tell you that it cannot execute the command until you accept the
pending cell change. To fix this problem, go back to the Data window and press Enter,
Return, Tab, or an arrow key. The highlighted cell then fills in, enabling you to issue a
command. Thus, whenever Minitab will not accept a command, make sure that the cur-
rent cell in the Data window is filled in. Similarly, if you have not finished executing a com-
mand in the Session window, Minitab will not let you select items from the menus.

Alpha Columns:

Entering any letters into a column converts it to an alpha column, preventing you from
performing any mathematical operations on that column. If you accidentally type a letter
and notice your mistake before you complete the cell, use the delete key or select Edit

Undo Cell Changes (Macintosh Student) or Edit Undo Change Within a Cell (Macin-
tosh Professional, Windows Student). An alternative is to use the erase command, which
deletes the entire column and removes the alpha column designation. You can then reen-
ter the numeric data. In the Windows version you can choose Manip Change Data Type
as well.

Saving Your Worksheet:

When you are entering your own data, you should periodically save the worksheet by
choosing File Save (Current) Worksheet. If you have not already done so, Minitab asks
you to name the worksheet and then creates a file with that name and the extension .mtw.
You should save the worksheet onto your disk directly. See Activity 2-1 on page 21 for an
example. Use File Save (Current) Worksheet As to save an existing worksheet under a
new name. This is useful for creating your own copies of the textbook worksheets before
you make changes to them.
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Saving Minitab Output:

There are three main ways to save Minitab output:

(a) Recording Sessions: (Macintosh versions, Windows Student version)

You may occasionally want to keep a record of the Minitab output and the commands you
have used. Initiate this process by selecting File Other Files Start Recording Session
from the menu bar. You should always remember to do this before you start working. Click on the
SELECT FILE button in the next window or press Return/Enter. In the next window,
enter a name for the file in the box under “Record Session as” or “File name.” You should
always save these files to your disk. Click on the SAVE/OK button, and Minitab creates a
file with this name and the extension .lis. You can close this .lis file by either exiting
Minitab or choosing File Other File Stop Recording Session. If you then choose Start
Recording Session again later, and use the same name, the new output will be appended
to the file. The .lis file can be opened by most word-processing applications, so that you
may edit your output. Open the .lis file from within the word-processing application; do
not try to double click on the file icon.

(b) Saving the Session Window:

If you forget to record the session, you can still save all of the output contained in the Ses-
sion window. Make sure the Session window is highlighted and choose File Save (Ses-
sion) Window As. You should change folders, name the file, and save it to your disk. This
file can then be opened by any word-processing program.

(c) Cutting and Pasting Minitab Output:

If you have both Minitab and a word-processing program open at the same time, you can
select portions of the Minitab output by holding the mouse button down and dragging
over that section. Once the region you desire is selected, choose Edit Copy or type zC/
ctrl C to copy that text. Move to the word-processing document and then select Edit

Paste or type zV/ctrl V to paste the section where you want it in your word-processing
document.

Saving High-Resolution Graphs:

When Minitab creates a high-resolution graph, the graph appears in a new window instead
of in the Session window. To save this graphics window, make sure the window is active and
choose File Save Window/Graph As. You can then name this graphics file and save it to
your disk. The Windows versions will add the .mgf extension. This graph can then be
imported into a word-processing program. Alternatively, you can copy the graphics win-
dow (Edit Copy Graph) and then paste the graph into a word-processing file.
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Printing High-Resolution Graphs:

If you want to print a high-resolution graph directly, make sure the graphics window is
highlighted and choose File Print Window/Graph. Click on OK in the Print Window
screen. The graph can then be labeled and included with your work. Note: It is often more
economical to import the graph into a word-processing file first and then add text and
comments around the graph. In many applications, you can trim the excess white space
surrounding these graphs by clicking on the graph once and then holding the shift key
down while you use the mouse to move the edge of the picture inward.

When you are done with the graphics window, you can click in the box in the upper left
corner (Macintosh) or upper right corner (left square, Windows) of the window to close it.
Notice that you can get this window back by selecting its name from the bottom of the
Window submenu. To get rid of the window permanently, choose Window Manage
Graph (Windows) or Window Discard Graph (Macintosh). In the Windows versions, you
can also click in the right square (with the X) in the upper right corner.

Using Macros:

You will occasionally be asked to execute Minitab macros, which are files that contain a
sequence of Minitab commands. To run a macro, choose File Other Files Execute
Macro (Macintosh Student) or File Other Files Run an Exec (other versions) from the
menu bar.

Minitab will first ask you how many times you want to run the macro. You should usually
run the macro once to make sure that it works and then as many more times as is required
for the activity. Next you have to tell Minitab which macro to execute. This book assumes
that macros are stored in the default Minitab Macros folder and always end in the exten-
sion .mtb. You can view the commands issued by the macro by opening up this .mtb file
in any word-processing application.

Printing Data:

You cannot print data directly from the Data window. To print some or all of the data, use
the print command, e.g.,

MTB> print c1-c5

which will type the data in columns 1–5 into the Session window, where it can be recorded,
saved, or printed directly. In the Macintosh versions, you can use the mouse to select the data
and then choose File Print Selection from the menu bar.
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Getting Minitab Help:

Minitab has extensive on-line help documentation. To view the help files, you can either
choose Help from the apple menu (Macintosh) or choose Help from the Minitab menu
bar (Windows) or type help at the MTB> prompt in the Session window. You can also type
help followed by a command to find help on a specific command. For example, typing

MTB> help commands

displays a table of contents for all possible Minitab commands. Double clicking on one of
these commands will give you an information window for that command and list any
potential subcommands.

Quitting Minitab:

When you are done using Minitab, click on File in the menu bar and drag the mouse to
Quit/Exit or hit zQ (Macintosh) or Alt-F-X (Windows) to quit the program.

If you have been using a Minitab worksheet created for class use, you should NOT save
your changes to the worksheet. You should either save the changes under a different work-
sheet name on your disk (File Save Worksheet As) or simply exit Minitab and answer NO
when asked whether you want to save changes.

Please note that closing all windows is not equivalent to exiting the Minitab program.

Glossary of Minitab Commands:

Listed below are some commonly used Minitab commands, arranged by the type of func-
tion the command performs. Use the help command to see how the commands should
be formatted. While the commands are listed with specific columns, any columns can be
substituted. When k1-k4 appear, numerical values (constants) should be used. Many of
the descriptive words in the command are not needed to run the command, but are used
here to clarify the command. The corresponding path through the Minitab menu bar is
also given. More information may be found in the text by looking for the command name
in the index.

Editing and Manipulating Data (also see the Calc menu)
Performing algebraic manipulations: let c3=c1+c2

Creates a new column (C3) adding data from C1 and C2
Can also use let with abs, sqrt, loge, logten, expo, round
You can name the new column from the session window with name.

Delete rows from selected columns:  dele 1,2 c2
This would delete rows 1 and 2 from column 2.

Delete columns (all rows): erase c1-c5

Ø
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This would erase all the data in columns 1–5.
Code data values: code (k1 k2) (k3 k4) c1-c5 c6-c10

Here, k1 and k2 have the old values, and k3 and k4 have the desired new values.
These changes are being applied to columns 1–5, and the new columns are put in
C6–C10 (could use C1–C5 again). Examples of use: changing from 0’s and 1’s to 1’s
and 2’s or recoding specific values.
Can also code ranges of data: code (k1:k2) 5 c1 c2
This would change all values in column 1 that are between k1 and k2 into a 5 and
put the results in column 2.

Change text column to numbers:  Manip Change Data Type Text to Numeric 
Combine several columns: MTB> stack c2 c3 into c4; MTB> subs c5.

Takes data in columns 2 and 3 and puts them together into one column, stored in
C4. C5 will contain 1’s and 2’s, indicating whether the corresponding data point in
C4 came from C2 or C3. Can be used to stack any number of columns. 

Can reverse this process using the unstack command.
Make a two-way table:  table c1 c2 (See also Stat Tables Cross Tablulation)

C1 contains outcomes for one categorical variable, and C2 contains outcomes for a
second categorical variable. Each row represents one observational unit (the col-
umns must have equal number of rows). This command makes a two-way table cross-
classifying the two variables. There is a chi-square analysis option in the Tables
Cross Tabulation menu, or this two-way table can be typed into new columns and
used with the chisq command. 

Descriptive Statistics (also see Stat Basic Statistics)
One variable: mean, stdev, median, min, max, describe, info, sum, tally

Applied to a specific column (e.g., mean c1) calculates the desired information for
that column.
describe: gives the sample size, mean, median, trimmed mean (dropping 5%
on both ends), standard deviation, standard error, min, max, and quartiles for that
column. Can be used for multiple columns.  
Can be used with the by subcommand, which separates the data into groups first,
using a subscripts column (a categorical variable indicating the groups).
info:  Gives the name and count for each column in the worksheet.
sum:  Adds the values in the column.

  tally:  Displays the number of occurrences for each observation. 
Can also perform arithmetic across rows using Calc Row Statistics.

Two variables: corr c1 c2
Calculates the correlation coefficient between paired data in columns 1 and 2. Each
row represents one observational unit, and columns must be of equal length. 

Plotting Data (also see Graph menu)
One variable: dotplot, histogram, stemplot, boxplot

Applied to specific columns (e.g. hist c1-c2) produces the desired plot.
Two variables: plot (scatterplot), lplot (includes labels). 
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Applied to two columns of paired data (e.g. plot c1*c2). The lplot allows you
to “tag” different groups from a third (categorical) variable.

Many of these plots have subcommands, in particular, the by subcommand for separating
the column data by groups, e.g.,

MTB> boxplot c1; 
SUBC> by c2.
In this form, all the quantitative observations are in C1, and the categorical group-
ing variable is in C2 (so may need to stack the data before you run this command).

Inference Procedures (also see Stat Basic Statistics menu)
Basic Inference: One proportion, Two proportions

1 sample t, 2 sample t, Paired t  
Often applicable to column of data or summarized data. With two-sample t, data can be
stacked with column of subscripts or separate columns.

For the confidence intervals, can set confidence level. For the one sample tests,
need to give the hypothesized value of the population parameter (or zero is
assumed). See the Help menu for more detailed description of how to format the
command. 

Can calculate the power of a procedure using Stat Power and Sample Size.
Regression: (See also Stat Regression Regression)

regress c1 1 c2
Here C1 is the response variable; C2 contains the data for the explanatory variables.
Columns must have same length.  
Can use a subcommand to store the residuals of the regression, e.g.,
regress c1 1 c2;
resids c3.

Chisquare:(See also Stat Tables Chi-Square Test) 
chisquare on table in c1-c3

Enter the two-way table directly into the Minitab worksheet, then apply the chi-
square command to those columns. Will calculate the expected counts and test sta-
tistic. See above for how to create the table from raw data.

Simulation (also see Calc Random Data)
Generating random data:

random k observations into each of c1, c2, c3 
Randomly selects k values per sample and puts a sample in each column specified.
The default is to sample from a Standard Normal distribution. Use the subcom-
mand option to specify other distributions and their parameters.

Sampling data:  sample k rows from c1-c3 put into c4-c6 
Samples k observational units from columns C1–C3 and put the samples into the
second set of columns specified (e.g., C4–C6).  
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Calculating Normal Probabilities (see also Calc Probability Distributions)
Finding the probability below:

MTB> cdf 15;
SUBC> Normal 20 5.

Finds the probability below the value you specify for k.  
Example output: x P(X <= x)

15 .1587
So for a Normal(20,15) distribution, P(X < 15) = .1587
Assumes a Standard Normal distribution unless you use the subcommand option
to specify otherwise.
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